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Die Seriennummer finden Sie auf der Rückseite des Geräts. Notieren Sie die Seriennummer in dem 
dafür vorgesehenen Feld weiter unten. Halten Sie sie bereit, wenn Sie sich an einen autorisierten 
Apogee Electronics-Reparaturfachbetrieb oder an den Hersteller wenden. Senden Sie die ausgefüll-
te Garantiekarte umgehend zurück!

Ensemble Seriennummer_________________________________________________

Kaufdatum__________________________________________________________
 
Händler_________________________________________________________________

Telefon_________________________________________________________________

Adresse________________________________________________________________

ACHTUNG:
Vom Benutzer vorgenommene Änderungen, die nicht ausdrücklich von APOGEE ELECTRONICS 
CORPORATION genehmigt wurden, können gemäß der FCC-Bestimmungen zur Aufhebung der 
Nutzungsrechte dieses Geräts führen.

Bitte füllen Sie die beiliegende Registrierungskarte aus, um das Gerät zu registrieren oder 
registrieren Sie es online unter http://www.apogeedigital.com/support/register.php 
Bitte lesen Sie dieses Benutzerhandbuch sorgfältig durch, bevor Sie die technische Hotline 
anrufen. Sie werden einige Fragen beantworten müssen.

Benutzerdaten
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Einführung

Ensemble ist ein speziell für Apple Macintosh-Computer entwickeltes digitales Firewire-Audiointerface. 
Von Mikrofon-Vorverstärkern über Anschlüsse für Mac Core Audio bis hin zu den Kopfhörerausgängen 
bietet Ensemble alle notwendigen Funktionen für ein hochwertiges Aufnahmesystem für den Mac.

Ensemble verfügt über diverse Apogee-Grundtechnologien, z.B.:

SoftLimit 

Soft Limit ist ein analoger Spitzenlimiter, der schnell und effektiv auf kurzzeitige Pegelspitzen anspricht 
und so zusätzliche 4 dB Headroom zulässt. Soft Limit kann für alle 8 analogen Eingänge von Ensemble 
aktiviert werden.

UV22HR 

UV22HR ist Apogees Industriestandard-Dither-Algorithmus, um die Wortlänge digitaler Audiosignale von 
24 auf 16 Bits zu reduzieren. Er wird zudem eingesetzt, um deutlich bessere Internet- und Computer-
Audioinhalte zu erstellen, ohne dabei die Dateien oder Datenraten zu vergrößern. 

Apogee Sample Rate Conversion (SRC)

Der Hardware-Samplerate-Wandler ist eine hochwertige, flexible Lösung, um mit digitaler Audio-
Hardware und -Software unterschiedlicher Samplefrequenzen zu arbeiten. Der Samplerate-Wandler 
von Ensemble kann sowohl für digitale Eingänge (um das Eingangssignal an die Samplefrequenz von 
Ensemble anzugleichen) als auch für digitale Ausgänge (um das Ausgangssignal in die gewünschte 
Samplefrequenz umzuwandeln) eingesetzt werden.

Systemvoraussetzungen für Ensemble

1.	Apple PowerMac 1,5GHz oder höher, 512MB RAM benötigt, 1GB empfohlen
2.	OS X 10.4.11 oder 10.5 und höher; OS X 10.5.3 oder höher dringend empfohlen
3.	Apple Logic Pro 7.2.3 oder 8.0 und höher
4.	1 Firewire 400-Kabel

Bitte beachten Sie:
Die in diesem Handbuch beschriebenen Funktionen basieren auf der Ensemble Firmware 
und Software Version 1.3, ausgegeben im Februar 2007.
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Schnellstart-Anleitung

1. Software-Installation
	 Legen Sie die beiliegende CD in das optische 

Laufwerk Ihres Macs, doppelklicken Sie das 
Ensemble Software Installer -Symbol und folgen 
Sie der Bildschirmführung des Installers. Nach er-
folgreicher Installation ist ein Neustart erforderlich.

2. Anschluss der Hardware
	 Schließen Sie das mitgelieferte FireWire-Kabel 

an einen der FireWire-Ports von Ensemble und 
an einen FireWire 400-Port Ihres Macs an 

	 (Abb. 2).
	

	

	 Schließen Sie das Netzkabel an den Netzein-
gang von Ensemble und an eine Steckdose 
(AC 90-250 V) an; bei anliegendem Wechsel-
strom leuchtet der Netzschalter von Ensemble. 
Drücken Sie den Power-Knopf, um das Gerät 
einzuschalten (Abb. 3).

	 Schließen Sie Ihre Kopfhörer an den Ausgang      
 1 an (Abb. 4). 

Abb. 1

Abb. 2

Abb. 3

Abb. 4



APOGEE ELECTRONICSEnsemble – Benutzerhandbuch

5

3. OS X-Konfiguration
	 Öffnen Sie im Mac Apfel-Menü die System-
	 Präferenzen und klicken Sie auf das Sound-

Symbol (Abb. 5).
	

	 In den Sound Preferences klicken Sie auf den 
Reiter Output und wählen Sie Ensemble 

	 (Abb. 6).
	

Abb. 5

Abb. 6

4. Wiedergabe in iTunes
	 Öffnen Sie iTunes, wählen Sie eine Audiodatei 

aus und starten Sie die Wiedergabe (Abb. 7).

	 Drücken Sie den OUTPUT-Drehregler bis die 
LED  1 leuchtet und stellen Sie die Lautstärke 
für Ihre Kopfhörer ein (Abb. 8).

	

Abb. 7

Abb. 8

Schnellstart-Anleitung
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Schnellstart-Anleitung

5.  Konfiguration Ihrer DAW
	 Konfigurieren Sie Ihre Core Audio-kompatible 

Software, um mit den Ein- und Ausgängen der 
Ensemble-Hardware zu kommunizieren. 

	 Etwa in Logic 8 Pro:

	 Gehen Sie zu Preferences > Audio und klicken 
Sie auf den Devices -Reiter. Im Geräte -Fenster 
klicken Sie auf den Core Audio -Reiter (Abb. 9).

	

	 Setzen Sie ein Häkchen in das Kontrollkästchen 
Enabled, wählen Sie Ensemble im Geräte -Feld 
und vergewissern Sie sich, dass die Option 

	 24 Bit Recording aktiviert ist. Klicken Sie 
	 anschließend auf Änderungen übernehmen 

(Abb. 10).
	

	 Um die Namen der Ein- und Ausgänge von Logic 
denen der Ensemble-Hardware anzupassen, 
wählen Sie Optionen > Audio > I/O Labels. 
Klicken Sie auf den Kreis neben den einzelnen 
Labels unter der Spalte Provided by Driver 
(Abb. 11).

	 Um Ensemble direkt aus Ihrer Logic-
	 Session zu steuern, wählen Sie Optionen > 
	 Audio > Apogee Control Panel öffnen 
	 (Abb. 12).

	 Falls Sie eine andere Core Audio-kompatible 
Audiosoftware einsetzen, verwenden Sie die 
Maestro-Software von Apogee (die im ersten 
Schritt im Verzeichnis Anwendungen installiert 
wurde) um Ensemble zu steuern.

	

Abb. 9

Abb. 10

Abb. 11

Abb. 12
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6. Aufnahme 	
	 Schließen Sie ein Mikrofon an den 
	 MIC 1 -Anschluss an der Rückseite an 
	 (Abb. 13). 

	
	
	 Oder ein Instrument an den HI–Z 1-Anschluss 

an der Vorderseite (Abb. 14).

	

	 Stellen Sie in Logic den Eingang des Tracks auf 
Analog 1, den Ausgang des Tracks auf Analog 
1/2 und aktiveren Sie den Aufnahmemodus des 
Tracks (Abb. 15). 

	 Drücken Sie den INPUT -Drehregler an der Vor-
derseite, bis die Pre 1 -LED leuchtet und stellen 
Sie dann mit dem Regler einen angemessenen 
Aufnahmepegel für den Track ein (Abb. 16).

	   
      Das Gerät ist nun für die Aufnahme bereit!

Abb. 13

Abb. 15

Schnellstart-Anleitung

Abb. 16

Abb. 14
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Einstellungen über die Software Control Panel

Sämtliche Einstellungen für Ensemble werden im Settings -Panel der Apogee Maestro-Software oder im Apogee 
Control Panel von Logic Pro vorgenommen. Einige Einstellungen können auch über das OS X-Audio-Control 
Panel vorgenommen werden. Sie können mehrere Control Panel geöffnet haben; wenn Sie die Einstellungen 
in einem Control Panel ändern, werden Sie in den anderen automatisch übernommen. Mic Pre Gain und 
Ausgangspegel können mit den Reglern an der Vorderseite von Ensemble eingestellt werden, wie im unteren 
Abschnitt auf dieser Seite beschrieben. 
	
Was ist Maestro? - Mit Apogee Maestro können Sie sämtliche Funktionen von Ensemble steuern, einschließlich 
sämtliche Parameter, Store/Recall-Einstellungen, erweiterte Routing-Einstellungen und die beiden Mixer mit 
geringen Latenzzeiten. Maestro kann mit jeder beliebigen Core Audio-kompatiblen Audioanwendung eingesetzt 
werden. Siehe hierzu bitte die Erläuterungen zum Maestros Settings -Panel auf S. 14.

Über das Logic Pro Apogee Control Panel im Audio -Menü von Logic Pro können sämtliche Ensemble-
Parameter eingestellt und die Konfigurationen gespeichert und aufgerufen werden.

Audio Midi Setup (AMS) – Mit diesem OS X-Dienstprogramm (im Ordner Applications/Utilities) können Sie den 
Taktgeber, die Samplefrequenz und den Ausgangspegel von Ensemble einstellen. 

Um den Ausgangspegel von Ensemble über den Lautstärkeregler in der Menüleiste Ihres Mac einzustellen, stellen 
Sie Default Output (in AMS) auf Ensemble; die OSX-Lautstärkeregler (auch der in der Menüleiste) steuern 
somit den an der Vorderseite von Ensemble ausgewählten Ausgang. Wenn zum Beispiel die LED  1 an der 
Vorderseite leuchtet, steuern Sie mit den OSX-Lautstärkereglern den Ausgangspegel  1.

Einstellungen über die Drehregler an der Vorderseite

Über die Drehregler an der Vorderseite von Ensemble kann der Mic Pre-Gain und die Ausgangslautstärke schnell 
und einfach eingestellt werden. 

Um mit dem linken Drehregler den Mic Pre-Gain einzustellen:

	 Wählen Sie den Mic Pre-Gain, den Sie einstellen möchten, indem Sie auf den linken Drehregler klicken, bis 
	 die gewünschte PRE -LED leuchtet.
	 Drehen Sie den Regler im Uhrzeigersinn, um den Wert anzuheben, und gegen den Uhrzeigersinn, 
	 um ihn zu senken.
	 Die LEDs rings um den Regler zeigen seine "Position" an. So lässt sich der Pegel wie bei einem 
	 herkömmlichen Drehregler leicht ablesen.

Um mit dem rechten Drehregler die Ausgangspegel einzustellen:

	 Wählen Sie den Ausgang, den Sie einstellen möchten, indem Sie auf den rechten Drehregler klicken, 
	 bis die gewünschte LED leuchtet, und drehen Sie den Regler wie oben beschrieben; wählen Sie MAIN, um 
	 die analogen Ausgänge der Rückseite einzustellen; wählen Sie  1 oder  2 , um die Pegel der 
	 entsprechenden Kopfhörerausgänge der Vorderseite einzustellen.

	 Halten Sie den rechten Drehregler einige Sekunden lang gedrückt, um alle analogen Ausgänge 
	 stummzuschalten. Die LED des ausgewählten Ausgangs blinkt, wenn dieser stummgeschaltet ist.

Auf S. 16 wird beschrieben, wie Sie die MAIN - und Kopfhörerausgänge konfigurieren.

Allgemeiner Betrieb
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Samplefrequenz einstellen

Um die Samplefrequenz für Ensemble einzustellen, wählen Sie die gewünschte Frequenz in Ihrer Core 
Audio-kompatiblen Anwendung. Ensemble passt sich automatisch an diese Einstellung an. Falls sich die 
Samplefrequenz in der Anwendung nicht einstellen lässt, öffnen Sie das OSX-Dienstprogramm Audio Midi 
Setup, wählen Sie im Feld Properties For den Eintrag Ensemble und im Feld Format die gewünschte 
Samplefrequenz aus.

Verwendung von 176.4–192 kHz Samplefrequenzen

Um Ensemble mit einer Samplefrequenz von 176.4-192k zu verwenden, muss I/O Allocation (in Maestro 
im ReiterTools>Settings>Settings ) entweder auf 10x10 oder 8x8 gestellt werden. Da diese Samplefre-
quenzen keine optischen Ein- und Ausgänge unterstützen, werden die entsprechenden Firewire-Pfade 
deaktiviert, um CPU-Bandbreite freizugeben.  
Nachdem Sie die I/O Allocation geändert haben, sollten Sie Ihren Computer neu starten und Ensemble 
aus- und wieder einschalten.

Clock Source auswählen

Den Taktgeber für Ensemble können Sie in Maestro, im Control Panel von Logic Pro Apogee oder im 
Audio MIDI-Setup von OS X einstellen.

Wenn Ensemble an einen externen Taktgeber gekoppelt ist, wird die Samplefrequenz von der Auswahl 
in der Software bestimmt. Deshalb muss die Samplefrequenz der externen Quelle manuell an die 
Samplefrequenz der Software angepasst werden. Wenn Sie z.B. eine Session mit 88,2 kHz öffnen 
möchten, Ensemble aber an einen Taktgeber von Apogee Big Ben koppeln, müssen Sie Big Ben manuell 
auf 88,2 kHz stellen.

Digital I/O

Die Verfügbarkeit der digitalen Ein- und Ausgänge von Ensemble ist abhängig von der Samplefrequenz 
des Geräts und der Optical I/O Format -Einstellungen, wie aus unten stehender Tabelle ersichtlich.

Standalone-Modus

Wenn die Firewire-Verbindung von Ensemble unterbrochen wird, wechselt das Gerät automatisch in den 
Standalone-Modus. Trotz fehlenden Host-Computers bleiben dabei alle Einstellungen der Control Panel und 
des Mixers aktiv. Im Standalone-Modus leuchtet die Status-LED grün und alle Regler an der Vorderseite 
bleiben aktiv.

Routing von Ensemble

Sofern das Routing nicht in der Maestro-Software geändert wird, werden alle Eingänge der Rückseite von 
Ensemble über Firewire an den Mac geroutet, während die Ausgänge der Rückseite über Firewire vom Mac 
geroutet sind; s. die Abbildungen auf den folgenden zwei Seiten. 

Analog I/O Optical I/O Coaxial I/O Gesamt
44k1/48k 8 8 ADAT oder 2 S/PDIF 2 18
88k2/96k 8 4 SMUX oder 2 S/PDIF 2 14

176k4/192k 8 kein 2 10

Allgemeiner Betrieb
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18 DAW Inputs18 Hardware Inputs 
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Allgemeiner Betrieb

Schaltbild Eingangs-Routing
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18 DAW Outputs
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Allgemeiner Betrieb

Schaltbild Ausgangs-Routing
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Maestro Control: Settings - Settings

Sämtliche Einstellungen für Ensemble werden im Settings -Panel der Apogee Maestro-Software oder im Apogee Con-
trol Panel von Logic Pro vorgenommen. Falls Sie Logic Pro verwenden, siehe die Beschreibung des Apogee Control 
Panels in der Logic Pro-Dokumentation. 

Unit select - Wenn mehrere Apogee-Geräte an den Computer angeschlossen sind, wählen Sie hier das Gerät aus, das 
aktuell von Maestro gesteuert wird.

Identify Unit – Wenn Sie diese Option aktivieren, leuchten alle LEDs an der Vorderseite des "aktiven" Ensemble-Geräts, 
um schnell feststellen zu können, welche Hardware von dem Software-Control Panel gesteuert wird.

Clock Source Select – Aus diesem Dropdown-Menü stellen Sie die Quelle des Taktgebers für Ensemble entweder auf 
Internal, oder auf den S/PDIF Coax-, den optischen bzw. Word Clock-Eingang auf der Rückseite. 

SRC Select – Die Wandlung der Samplefrequenz wird auf den Stereo-Audiopfad angewendet, den Sie aus diesem 
Dropdown-Menü auswählen . Wenn Sie einen digitalen Eingang (einer beliebigen Frequenz) auf die Samplefrequenz 
von Ensemble umwandeln (und somit die Session der DAW), wenden Sie die Frequenzänderung auf den digitalen 
Eingang an.

SRC Rate – Wenn Sie die Samplefrequenz des Ausgang der DAW-Session umwandeln, wenden Sie die Wandlung 
auf einen digitalen Ausgang an (unter SRC Select) und wählen Sie die gewünschte Zielfrequenz aus dem SRC Rate 
-Dropdown-Menü aus.

UV22HR – UV22HR wird auf den in diesem Dropdown-Menü ausgewählten Stereo-Audiopfad angewendet. UV22HR 
sollte auf analoge und digitale Eingänge angewendet werden, wenn Sie eine 16-Bit-Session aufnehmen, und auf digitale 
Ausgänge, wenn Sie Signale von Ensemble zu digitalen 16-Bit-Geräten routen, z.B. externe CD-Brenner oder DAT-
Recorder. UV22HR ist nur mit einer Samplefrequenz von 44,1kHz – 48k verfügbar, da Formate und Geräte höherer Fre-
quenzen nur mit 24-Bit arbeiten.

I/O Allocation – In diesem Dropdown-Menü können Sie bestimmen, wie viele Kanäle Sie über Firewire I/O bereitstellen 
möchten. Wenn Sie mit einem langsameren Host-Computer und/oder höheren Samplefrequenzen arbeiten, wird der 
Prozessor durch eine Bereitstellung von weniger Kanälen für die Firewire-Kommunikation weniger beansprucht. Beachten 
Sie bitte, dass bei einer Auswahl von 18 x 18 Kanälen die höchstmögliche Samplefrequenz 96kHz beträgt. Außerdem 
kann jede Hardware-I/O über die in den Routing-Seiten von Maestro verfügbaren Firewire-I/O geroutet werden.

Bandwidth used – Diese Anzeige zeigt die von allen Firewire-Audiogeräten verwendete Bandbreite in Prozent an, die an 
den interne Firewire-Bus des Computers angeschlossen sind. Die von Festplattenlaufwerken benötigte Bandbreite wird 
dabei nicht berücksichtigt. Wenn 100% angezeigt wird, wählen Sie eine kleinere I/O Allocation. 

Optical In – Aus diesem Dropdown-Menü wählen Sie für den optischen Eingang auf der Rückseite das digitale Format S/PDIF 
oder ADAT/SMUX aus.

Optical Out – Aus diesem Dropdown-Menü wählen Sie für den optischen Ausgang auf der Rückseite das digitale Format 
S/PDIF oder ADAT/SMUX aus.

Meter Display – Wählen Sie aus diesem Dropdown-Menü das Signal aus, das in den Displays auf der Vorderseite an-
gezeigt werden soll. Verfügbare Einstellungen sind Off (keine Anzeige), Input (Anzeige der Ensemble-Eingangssignale) 
oder Output (Anzeige der Ensemble-Ausgangssignale).

Word Clock Out – In diesem Dropdown-Menü können Sie den Taktgeber entsprechend der Samplefrequenz des Geräts 
(Word Clock x 1) oder auf die Hälfte der Samplefrequenz des Geräts (Word Clock x 1/2) einstellen, um ihn angeschlosse-
nen Geräten anzupassen. 
 
CD Mode – Wenn Sie diese Option aktivieren, wird ein 44,1kHz, 16–Bit-Stereosignal an den S/PDIF Coax-Ausgang 
gesendet, unabhängig von der Samplefrequenz oder Bittiefe der DAW-Session. CD Mode stellt UV22HR auf S/DPIF Out, 
und falls die DAW-Session mit einer anderen Samplefrequenz als 44,1kHz läuft, wird SRC Select auf S/PDIF Out und 
SRC Rate auf 44,1kHz gestellt.

Hold Overs – Wenn Sie diese Option aktivieren, leuchten die roten Over-Anzeigen auf der Vorderseite und auf der 
Settings/Output-Seite von Maestro, bis Sie den Clear Meters-Button (im Mixer-Fenster von Maestro) klicken.

Input-Einstellungen : Soft Limit – Hier aktivieren Sie den Soft Limit-Überlastungsschutz von Apogee für den entspre-
chenden analogen Eingang.

Input-Einstellungen : +4, –10, MIC – Mit diesen Radiobuttons wählen Sie den nominellen Referenzpegel der einzelnen 
analogen Eingänge aus. Die Eingänge 1–4 können auch auf MIC gestellt werden, so dass Sie den Gainpegel auf +10 bis 
+75 dB setzen können.

Output-Einstellungen – Mit diesen Radiobuttons wählen Sie den nominellen Referenzpegel der einzelnen analogen 
Ausgänge aus.
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Maestro Control: Settings - Settings (Schaltbild)
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Maestro Control: Pegel - Ausgang

Level Control – Mit diesen drei Reglern stellen Sie die Lautstärke der Ausgänge Main, HP1 und HP2 ein. Die Aus-
gangsdämpfung von 0 -127 dB wird im entsprechenden Display angezeigt. 

Meter Display – Im entsprechenden Display wird das Signal angezeigt, das an dem Kanal anliegt, welcher in den 
Dropdown-Menüs MAIN Format Select oder HP 1–2 Source Select ausgewählt wurde.

MAIN Format Select – Über dieses Dropdown-Menü konfigurieren Sie die analogen Ausgänge für verschiedene 
Monitoring-Setups. 

	 Wenn in Format None ausgewählt ist, fungieren sämtliche analogen Ausgänge als reguläre Line-Ausgänge
	  und der Main -Level-Fader hat keine Funktion.

	 Wenn in Format Stereo eingestellt ist, steuern Sie mit dem Main -Lautstärkeregler (und dem Output 
	 -Regler auf der Vorderseite) die Lautstärke der analogen Ausgänge 1-2. Die Ausgänge 3–8 sind in diesem 
	 Fall reguläre Line-Ausgänge.

	 Wenn in Format 5.1 Surround eingestellt ist, steuern Sie mit dem Main -Lautstärkeregler (und dem Output
	  -Regler auf der Vorderseite) die Lautstärke der analogen Ausgänge 1-6. Die Ausgänge 7–8 sind in diesem
	  Fall reguläre Line-Ausgänge.

	 Wenn in Format 7.1 Surround eingestellt ist, steuern Sie mit dem Main -Lautstärkeregler (und dem Output 
	 -Regler auf der Vorderseite) die Lautstärke aller analogen Ausgänge.

HP1 HP2 Source Select – In diesem Dropdown-Menü wählen Sie die Quelle des Stereosignals für die Kopfhörer-
ausgänge an der Vorderseite aus.

1

2

3

4

Maestro Control: Pegel - Eingang

Pre1 – Pre4 – Folgende Regler stehen für Pre1–Pre4 zur Verfügung

Gain Control – Mit diesem Regler steuern Sie den Mic Pre-Gain. Mic Pre-Gain von +10 - +75 dB wird im entspre-
chenden Display angezeigt. 

Meter Display – Hier wird der Konvertierungsgrad des entsprechenden Kanals angezeigt; praktisch, wenn Sie den 
Mic Pre-Grain einstellen.

Groups – Die Gain-Steuerung von zwei oder mehr Pres kann gekoppelt werden, indem Sie sie aus diesem Drop-
down-Menü derselben Gruppe zuteilen. Der Gain-Offset der Pres vor der Gruppierung wird für die jeweilige Gruppe 
beibehalten.

Phase – Wenn Sie diese Option aktivieren, wird die Polarität des entsprechenden analogen Eingangs umgekehrt.

48V – Wenn Sie diese Option aktivieren, liegt 48V-Phantomspeisung am enstprechenden XLR-Eingang an.

Soft Limit – Hier aktivieren Sie den Soft Limit-Überlastungsschutz für den entsprechenden analogen Eingang.

1

2

3

4

5

6
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Maestro Control: Pegel - Ausgang (Schaltbild)

Maestro Control: Pegel - Eingang (Schaltbild)
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Maestro-Präferenzen
Die folgenden Maestro-Präferenzen beziehen sich auf angeschlossene Geräte: Für weitere Informationen zu 
Software-Präferenzen lesen Sie bitte das Maestro-Benutzerhandbuch.
 
Maestro automatisch starten, wenn ein Gerät angeschlossen wird
Wenn Sie diese Option aktivieren, wird Maestro automatisch gestartet, wenn Ensemble über den Firewire-Bus Ihres 
Macs erkannt wird.

Pop-Ups aktivieren
Wenn Sie diese Option aktivieren, werden Encoder-Pop-Ups auf dem Desktop angezeigt, wenn Sie die Regler der 
Vorderseite bewegen. Es werden verschiedene Einstellungen von Ensemble angezeigt, darunter die Auswahl der 
Ein- und Ausgänge, Pegel, Eingangs-Gruppen und stummgeschaltete Ausgänge. Hier einige Beispiele.

Pre1 Eingang ausgewählt

Regler auf 38dB

Pre3-Pre4 Eingänge gruppiert und 

ausgewählt

Regler 3 auf 40dB

Regler 4 auf 50dB
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Maestro-Präferenzen

Analoger (Main-)Ausgang ausgewählt

Regler auf -60dB

HP2-Ausgang ausgewählt

Regler auf 0dB



Bedienelemente auf der Vorderseite

1. 	 Ein/Aus-Taste - Drücken Sie diese Taste, um Ensemble ein- und auszuschalten. Wenn der Netzeingang 
angeschlossen ist, leuchtet die Taste schwach, um Standby-Modus anzuzeigen.

2. 	 STATUS-LED - Diese mehrfarbige LED zeigt den Status verschiedener Parameter an.
• 	 Wenn die LED blau leuchtet, ist Ensemble an den in der Software ausgewählten Taktgeber 

gekoppelt und der Firewire-Anschluss ist in Ordnung.
•	 Wenn die LED blinkt, ist Ensemble nicht an den ausgewählten Taktgeber gekoppelt.
• 	 Wenn die LED rot leuchtet, ist Ensemble nicht über Firewire angeschlossen. Nach wenigen 

Sekunden wechselt Ensemble in den Standalone-Modus.
•	 Wenn die LED grün leuchtet, ist Ensemble nicht über Firewire angeschlossen und befindet sich 

im Standalone-Modus.
• 	 Eine rot blinkende LED weist auf beide Fehler hin.

3. 	 HI–Z Eingang 1–2 – An diese 1/4”-Buchsen können hochohmige Quellen wie Keyboards und Gitarren 
angeschlossen werden. Wenn Sie einen Klinkenstecker in eine Hi-Z-Buchse stecken, wird der XLR-
Anschluss des Eingangs deaktiviert.

4. 	 INPUT Drehregler – Wenn die Eingänge 1–4 über die Software-Control auf MIC gestellt sind, steuern 
Sie mit diesem Regler den Mic-Pre Gain. Um den Eingang auszuwählen, drücken Sie den Regler, bis 
die gewünschte PRE-LED leuchtet. Drehen Sie den Regler im Uhrzeigersinn, um den Pegel anzuhe-
ben, gegen den Uhrzeigersinn, um ihn zu senken. Die LEDs rings um den Regler zeigen seine "Po-
sition" an. So lässt sich der Pegel wie bei einem herkömmlichen Drehregler leicht ablesen. Wenn in 
Software-Control keine Eingänge auf MIC gestellt sind, hat dieser Regler keine Funktion.

5. 	 PRE LEDs – Diese LEDs zeigen zusammen mit dem INPUT-Drehregler den ausgewählten Kanal an.

6. 	 48V LEDs – Diese LEDs leuchten, wenn in Software-Control die Phantomspeisung aktiviert wurde.

7. 	 Anzeigen 1–8 – Je nach Einstellung in Software-Control zeigen diese Displays die analogen Ein- oder 
Ausgänge an.

8. 	 Anzeigen D1,D2 – Das Display D1 zeigt das Signal auf den Kanälen der S/PDIF Coax-Ein- und Aus-
gänge an; das Display D2 das Signal auf den Kanälen des optischen Ein- und Ausgangs. 

9. 	 INPUT, OUTPUT LEDs – Zeigen an, ob die Displays Eingangs- oder Ausgangssignale anzeigen, je 
nach Einstellung im Software-Control.

10. 	MAIN, Phones 1,2 LEDs – Diese LEDs zeigen den ausgewählten Ausgang an, der über den 
	 OUT-Drehregler verändert wird.

11.	 OUTPUT-Drehregler – Mit diesem Regler verändern Sie den Pegel des ausgewählten Ausgangs, wie 
durch die MAIN, hp1 und hp2-LEDS angezeigt. Er funktioniert ähnlich wie der oben beschriebene 
Eingangs-Drehregler. Wenn in Software-Control Main auf None gestellt ist, hat dieser Regler keine 
Auswirkung auf die Main-Ausgänge.

12	  1,2 – Stereoklinkenbuchsen der Kopfhörerausgänge
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1. 	 MIC1–4 – XLR-Buchsen für den Anschluss von symmetrischen Mic- oder Line-Quellen. 
	 Der Eingangspegel wird in Software-Control eingestellt.

2. 	 INSERT SEND – RETURN (Kanäle 1–2) – Klinkenbuchsen für symmetrische Inserts vor dem 
A/D-Wandler. Wenn Sie einen Stecker in die RETURN -Buchse stecken, wird Insert Return 
aktiviert. 

•	 Der Insert Send-Anschluss kann auch als direkter Ausgang verwendet werden: Wenn 
nur der Insert Send belegt ist, wird der Signalfluss zum A/D-Wandler nicht unterbro-
chen.

•	 Der Insert Return-Anschluss kann auch als symmetrischer Line-Eingang für Stereo-
klinken verwendet werden.

3. 	 HI–Z (Kanäle 3–4) – Stereo-Klinkenbuchsen für den Anschluss hochohmiger Quellen für Kanä-
le 3–4, ähnlich den HI–Z -Eingängen auf der Vorderseite.

4. 	 ANALOG INPUT 5-8 – Stereo-Klinkenbuchsen für den Eingang von Line-Signalen für die 
Kanäle 5-8. Der Eingangspegel wird in Software-Control eingestellt.

5. 	 ANALOG OUTPUT 1-8 – Stereo-Klinkenbuchsen für den Ausgang von Line-Signalen für die 
Kanäle 1-8. Der Eingangspegel wird in Software-Control eingestellt.

6. 	 S/PDIF – Koaxial-Anschlüsse für digitale I/O im S/PDIF-Format.

7. 	 OPTICAL IN/OUT – Toslink-Anschlüsse für digitale I/O im S/PDIF-, ADAT- oder SMUX-Format. 
Das Format wird in Software-Control eingestellt.

8. 	 FIREWIRE – FW 400-Ein- und Ausgänge für die Verbindung mit eine Apple OSX-Computer.
Standalone-Modus – Wenn Ensemble keine gültige Firewire-Verbindung feststellt, wech-
selt es nach einigen Sekunden in den Standalone-Modus. Dies wird entweder durch eine 
rote STATUS-LED (bei vorhandener, aber nicht gültiger Firewire-Verbindung) oder eine 
grüne LED (bei fehlender Firewire-Verbindung)angezeigt. Im Standalone-Modus werden 
sämtliche Routing-, Mixing- und Reglereinstellungen der letzten Verbindung des Geräts 
mit einem Mac im Flash-Speicher von Ensemble gespeichert, so dass es auch ohne Com-
puter verwendet werden kann. So können Sie Ensemble auch als Standalone-Mixer oder 
A/D-D/A-Wandler einsetzen.

9. 	 WORD CLOCK IN/OUT – BNC-Anschlüsse für Word Clock-I/O.

10. 	WC IN 75 OHM TERM – Mit diesem Schalter terminieren Sie den Word Clock-Eingang mit 
einer 75 Ohm-Ladung.

11. 	AC IN – Kaltgeräte-Buchse für 90-250 V Wechselstrom.
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Anschließen Ihrer Studio-Geräte

2 Instrumente 2 Kopfhörer

DVD/CD

Aktiv- 
Lautsprecher

Synthesizer

Mikrofone

Basis-Studiokonfiguration
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Anschließen Ihrer Studio-Geräte

5.1-Surround-Konfiguration

5.1-Surround 
Lautsprecher-Setup
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Konfiguration Ihrer Audiosoftware

Apple Soundtrack Pro

Um Ensemble als Hardware-I/O auszuwählen:

1. 	Wiedergabe – Öffnen Sie das OS X-Dienstprogramm 
Audio Midi Setup (AMS) im Ordner Anwendungen > 
Dienstprogramme, und wählen Sie als Default Output 
den Eintrag Ensemble aus. (Abb. 24)

 
2. 	Aufnahme – Öffnen Sie in Soundtrack Pro 
	 Window > Recording und wählen Sie für Input und 

Monitor Device den Eintrag Ensemble aus. 	
(Abb. 25)

Um die Ensemble-Einstellungen zu steuern:

1. Öffnen Sie in Apogee Maestro Window > Settings.

Apple Final Cut Pro

Um Ensemble als Hardware-I/O auszuwählen:

1. 	Wiedergabe – Öffnen Sie Final Cut Pro > Audio 
Video Settings und wählen Sie für Audio Playback 
den Eintrag Ensemble aus. (Abb. 26)

2. 	Aufnahme – Öffnen Sie Tools > Voiceover und 
wählen Sie für Source den Eintrag Ensemble aus.

	 (Abb. 27)

Um die Ensemble-Einstellungen zu steuern:

1. Öffnen Sie in Apogee Maestro Window > Settings.

Konfiguration von Ensemble für weitere Audiosoftware

Wenn Sie Ensemble für Core Audio-Anwendungen konfigurieren möchten, müssen Sie
	  1) Ensemble aus dem Hardware-Treiber-Menü auswählen,
	  2) ein Software-Control Panel öffnen, um die Einstellungen für Ensemble vorzunehmen.

Abb. 24

Abb. 25

Abb. 26

Abb. 27
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Konfiguration Ihrer Audiosoftware

Abb. 28

Abb. 29

Abb. 30

MOTU Digital Performer

Um Ensemble als Hardware-I/O auszuwählen:

1. Öffnen Sie in Digital Performer Setup > Configure Au-
dio System > Configure Hardware Driver.  
(Abb. 28)

2. Wählen Sie für Master Device den Eintrag Ensemble 
aus (Abb. 29)

3. Wählen Sie für Work Priority den Eintrag Low aus 
(Abb. 29)

Um die Ensemble-Einstellungen zu steuern:

1. 	Öffnen Sie in Apogee Maestro Window > Settings.

	

Steinberg Nuendo
Um Ensemble als Hardware-I/O auszuwählen:

1.	Öffnen Sie in Nuendo Devices > Device Setup und 
wählen Sie VST Audiobay aus der Devices-Spalte.  
(Abb. 30)

2. Wählen Sie für Master ASIO Driver den Eintrag En-
semble aus. (Abb. 31)

3. Wenn die Frage "Möchten Sie einen anderen MASTER 
ASIO-Treiber auswählen?" erscheint, klicken Sie auf 
"Switch".

Um die Ensemble-Einstellungen zu steuern:

1. 	Öffnen Sie in Apogee Maestro Window > Settings.

Abb. 31
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Fehlerbehebung

Außer der blauen LED des Power-Schalters leuchtet keine andere LED. Ist das Gerät in 
Betrieb?

– Noch nicht. Wenn Sie Ensemble an das Netz anschließen, leuchtet der Power-Schalter 
schwach, um anzuzeigen, dass sich das Gerät im Standby-Modus befindet. Drücken Sie 
den Power-Schalter, um das Gerät einzuschalten.

Wie kann ich schnell überprüfen, ob das Ensemble-System ordnungsgemäß funktioniert?

– Prüfen Sie, ob die STATUS-LED blau leuchtet (bestätigt die Hardware-Clocks von 
Ensemble);
– prüfen Sie, ob die Seriennummer des Geräts in AMS erscheint (bestätigt die Firewire-
Audio-Verbindung);
– öffnen Sie Maestro (oder das Logic Pro Apogee-Control Panel), klicken Sie auf “Identify 
Unit” und vergewissern Sie sich, dass alle LEDs leuchten (bestätigt Firewire-Software 
Control-Verbindung).

Ensemble wird in meinem Audioprogramm oder in Audio Midi Setup nicht angezeigt.

– Prüfen Sie, ob die erforderliche Version von OS X installiert ist
– Leuchtet die blaue STATUS-LED von Ensemble? Falls nicht, überprüfen Sie die 
Firewire-Verbindung oder ersetzen Sie das Kabel.

Ich kann Ensemble aus Maestro oder dem Apogee Control Panel von Logic Pro nicht steu-
ern.

– Prüfen Sie, ob diese Datei vorhanden ist : System > Library >Extensions > 
apogfwplugin.bundle. Falls die Datei fehlt, installieren Sie die Software von der mitge-
lieferten CD erneut.

Kein Signal an den analogen Ausgängen 1-2.

– Öffnen Sie Maestro, wählen Sie für Meter Display den Eintrag Output und vergewis-
sern Sie sich, dass die Displays ein Signal anzeigen. Falls kein Signal angezeigt wird, 
prüfen Sie die Verbindung mit der Audioanwendung. Wenn ein Signal angezeigt wird, es 
aber nicht an den analogen Ausgängen 1-2 anliegt, prüfen Sie, ob der MAIN-Lautstärke-
regler aufgedreht ist (entweder in Maestro oder der OUTPUT-Regler der Vorderseite).

Der OUTPUT-Regler der Vorderseite dämpft das Signal an den analogen Ausgängen 1-2 
nicht.

– Wenn in Format Select None (in Maestro) ausgewählt ist, dämpft der OUTPUT-Regler 
der Vorderseite die Ausgabelautstärke nicht. Wählen Sie für Format Select den Eintrag 
Stereo aus.

Die Anzeigen funktionieren nicht.

– Vergewissern Sie sich, dass die METER-Einstellung im Apogee Control Panel in Logic 
nicht deaktiviert ist.
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Ich möchte Ensemble mit 176,4 –192 kHz betreiben, ich sehe aber nur 44,1–96 kHz in AMS.

– Ensemble kann mit den Samplefrequenzen 44,1 bis 96 kHz oder 176,4 bis 192 kHz betrieben 
werden, je nach Einstellung der Sample Rate Range im Settings-Panel von Apogee Maestro. 
Um den Samplefrequenz-Bereich zu ändern, öffnen Sie das Maestro>Window>Settings-Panel 
und stellen Sie unter Sample Rate Range den gewünschten Bereich ein. Wenn Sie den Bereich 
einstellen, schließen Sie alle Audioanwendungen und geben Sie Ensemble 30 Sekunden, um mit 
der neuen Einstellung hochzufahren

Ich möchte Ensemble an eine externe Quelle koppeln, aber die STATUS-LED hört nicht auf, 
zu blinken.

– Wenn Ensemble an einen externen Taktgeber gekoppelt ist, wird die Samplefrequenz nach wie 
vor von der Auswahl in der Software bestimmt. Deshalb muss die Samplefrequenz der externen 
Quelle manuell an die Samplefrequenz der Software angepasst werden. Wenn Sie z.B. eine Sessi-
on mit 88,2 kHz öffnen möchten, Ensemble aber an einen Taktgeber von Apogee Big Ben koppeln, 
müssen Sie Big Ben manuell auf 88,2 kHz stellen.

Wie setze ich Ensemble auf die Werkseinstellungen zurück?

– Ensemble kann auf die Werkseinstellungen zurückgesetzt werden, indem Sie den linken Dreh-
regler auf der Vorderseite drücken und das Gerät einschalten; halten Sie den Regler gedrückt, bis 
das Gerät hochgefahren ist.
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Warnungen und Urheberrechte

FCC-Warnung
Dieses Gerät wurde getestet und entspricht den Bestimmungen für digitale Geräte der Klasse A nach Teil 15 der 
FCC-Bestimmungen. Diese Grenzwerte bieten angemessenen Schutz vor Funkstörungen beim Betrieb des Geräts in 
gewerblich genutzten Räumen. Dieses Gerät erzeugt und nutzt Hochfrequenzenergie und kann diese abstrahlen und 
den Funkverkehr stören, wenn es nicht gemäß der Betriebsanleitung installiert und betrieben wird. Der Betreib dieses 
Geräts in Wohngegenden kann schädliche Interferenzen verursachen. In diesem Fall muss der Nutzer die erforderlichen 
Maßnahmen zur Behebung dieser Interferenzen auf eigene Kosten ergreifen.

Copyright-Hinweis
Apogee Ensemble ist ein rechnergestütztes Gerät; als solches enthält und verwendet es im Festspeicher Software. 
Diese Software sowie die dazugehörige Dokumentation einschließlich dieses Benutzerhandbuchs enthält urheberrechtlich 
geschützte Informationen. Alle Rechte sind vorbehalten. Die Software oder Teile davon und die dazugehörige 
Dokumentation darf nicht kopiert, übertragen oder verändert werden. Sie dürfen die Software oder Teile davon ohne 
schriftliche Genehmigung der Apogee Electronics Corporation, U.S.A. nicht verändern, übersetzen, verleasen, vertreiben, 
weiterverkaufen oder abgeleitete Anwendungen auf der Basis dieser Software oder Teilen davon erstellen.

Software-Hinweis
Die Weiterverteilung und Verwendung der Software, mit oder ohne Änderung, als Quellcode und in Binärform, ist unter 
folgenden Bedingungen gestattet:

•	 Der Quellcode muss den oben stehenden Copyright-Hinweis, diese Bedingungen und folgende Ausschlussklausel 
enthalten.

• 	 Die Binärform muss in der Dokumentation und/oder den mitgelieferten Materialien den oben stehenden Copyright-
Hinweis, diese Bedingungen und folgende Ausschlussklausel enthalten.

DIESE SOFTWARE WIRD VON DEN INHABERN DES URHEBERRECHTS UND DEN MITWIRKENDEN "SO WIE 
ES IST" OHNE GEWÄHRLEISTUNG, WEDER AUSDRÜCKLICHER NOCH IMPLIZITER ART, DIE UNTER ANDEREM 
EINSCHLIESST: GARANTIE DER VERKÄUFLICHKEIT UND EIGNUNG FÜR EINEN BESTIMMTEN ZWECK, 
ZUR VERFÜGUNG GESTELLT. WEDER DIE INHABER DES URHEBERRECHTS NOCH DIE MITWIRKENDEN 
HAFTEN FÜR DIREKTE, INDIREKTE, BEILÄUFIGE, SPEZIFISCHE ODER FOLGESCHÄDEN NOCH FÜR 
SCHADENSERSATZ (EINSCHLIESSLICH ABER NICHT BESCHRÄNKT AUF BEREITSTELLUNG UND ERSATZ 
VON GÜTERN ODER DIENSTLEISTUNGEN; NUTZUNGSSCHADEN, DATENVERLUST ODER ENTGANGENEM 
GEWINN ODER GESCHÄFTSUNTERBRECHUNG) UNABHÄNGIG VON DER ART DEREN ENTSTEHUNG, AUF 
GRUND IRGENDEINER HAFTUNGSLEHRE; SEI ES VERTRAGLICHE HAFTUNG, HAFTUNG AUS UNERLAUBTER 
HANDLUNG (EINSCHLIESSLICH FAHRLÄSSIGKEIT), DIE SICH AUS DER NUTZUNG DIESER SOFTWARE ERGIBT, 
SELBST WENN WIR ÜBER DIE MÖGLICHKEIT SOLCHER SCHÄDEN IN KENNTNIS GESETZT WURDEN.
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Konformitätserklärung — FCC

Apogee Ensemble
Dieses Gerät entspricht Teil 15 de FCC-Bestimmungen. Die Nutzung dieses Geräts unterliegt folgenden zwei Bedingungen: 
(1) Dieses Gerät darf keine schädlichen Interferenzen verursachen
(2) Dieses Gerät muss sämtliche Interferenzen annehmen, die es erhält, einschließlich solcher, die u.U. einen unerwünschten 
Betrieb zur Folge haben.
Dieses Gerät wurde getestet und entspricht den Bestimmungen für digitale Geräte der Klasse B nach Teil 15 der FCC-
Bestimmungen. Diese Grenzwerte bieten angemessenen Schutz vor Funkstörungen beim Betrieb des Geräts in einer 
Wohngegend. Dieses Gerät erzeugt und nutzt Hochfrequenzenergie und kann diese abstrahlen und den Funkverkehr stören, 
wenn es nicht anweisungsgemäß installiert und betrieben wird. Sollte dieses Gerät den Radio- und Fernsehempfang stören, 
was sich durch Ein- und Ausschalten des Geräts nachprüfen lässt, müssen Sie die Störungen durch eine oder mehrere der 
folgenden Maßnahmen beheben: 
1. Richten Sie die Empfangsantenne neu aus oder verlegen Sie sie neu.
2. Vergrößern Sie den Abstand zwischen Gerät und Empfänger.
3. Schließen Sie das Gerät an eine andere Steckdose an, so dass Gerät und Empfänger an verschiedene Stromkreise 
angeschlossen sind.
4. Fragen Sie den Händler oder einen erfahrenen Radio-/Fernsehtechniker um Rat.
HINWEIS: Die Verwendung von nicht abgeschirmten Kabeln ist verboten.
ACHTUNG: Vom für die Zulassung verantwortlichen Hersteller nicht ausdrücklich zugelassene Veränderungen an diesem 
Gerät können die Nutzungserlaubnis des Eigentümers unwirksam machen.

Apogee Electronics Corporation, 1715 Berkeley St, Santa Monica, CA 90404. 
Betty Bennett, CEO.

Industry Canada Notice

This Class B digital apparatus meets all requirements of the Canadian Interference–Causing Equipment Regulations. 
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matérial brouilleur du Canada.

Konformitätserklärung — CE

Apogee Electronics Corporation erklärt hiermit, dass das Produkt Ensemble, auf das sich diese Erklärung bezieht, im 
wesentlichen mit folgenden Normen oder anderen normativen Dokumenten übereinstimmt:
• EN50081–1/EN55022; 1995
• EN50082–1/IEC 801–2, 3, 4; 1992
und entspricht den Bestimmungen folgender Richtlinien:
• 73/23/EEC – Niederspannungsrichtlinie
• 89/336/EEC – EMC-Richtlinie

Declaration of Conformity – Japan

Apogee Electronics Corporation hereby declares that the Ensemble, to which this declaration relates, is in material conformity 
with the VCCI Class A standard.

Declaration of Conformity – Australia

Apogee Electronics Corporation hereby declares that the Ensemble is in material conformity with AN/NZS standard 
requirements.

Konformitätserklärungen
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Bitte registrieren Sie Ihr Ensemble, indem Sie entweder die beigefügte Registrierungskarte ausfüllen oder online 
auf unserer Webseite: http://www.apogeedigital.com/support/. Wenn Sie Ihr Gerät registrieren, kann Apogee Ihnen 
Informationen zu Updates zukommen lassen. Sobald Verbesserungen und Upgrades verfügbar sind, werden Sie 
benachrichtigt. Firmware-Updates sind ein Jahr lang ab Kaufdatum kostenlos, sofern nicht anders vermerkt. Bitte wenden 
Sie sich mit Fragen an Ihren Händler oder an Apogee:

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St, Santa Monica, CA 90404, USA. 
TEL: (310) 584–9394, FAX: (310) 584–9385
Email: support@apogeedigital.com. Web: http://www.apogeedigital.com/

APOGEE ELECTRONICS CORPORATION garantiert, dass dieses Produkt bei normalem Gebrauch für zwölf Monate 
frei von Material- und Herstellungsfehlern ist. Diese Garantie beginnt ab dem Kaufdatum. Geräte, die im Rahmen der 
Garantieleistung an Apogee oder an einen autorisierten Apogee-Reparaturdienst zurückgegeben wurden, werden nach 
Ermessen des Herstellers kostenlos repariert oder ersetzt. 
ALLE GERÄTE, DIE AN APOGEE ODER AN EINEN AUTORISIERTEN APOGEE-REPARATURDIENST 
ZURÜCKGEGEBEN WERDEN, MÜSSEN MIT IM VORAUS BEZAHLTEM PORTO, VERSICHERT UND 
ORDNUNGSGEMÄSS - VORZUGSWEISE IM ORIGINALKARTON - VERSENDET WERDEN. Apogee behält sich das 
Recht vor, das Design zu jeder Zeit und ohne Vorankündigung zu verändern oder zu verbessern. Diese Änderungen 
wirken nicht rückwirkend und zukünftige Änderungen des Designs impliziert nicht die Verfügbarkeit von Upgrades bereits 
vorhandener Geräte.

Diese Garantie ist unwirksam, wenn Apogee nach eigenem Ermessen befindet, dass etwaige Schäden aus 
missbräuchlicher oder nachlässiger Verwendung, Veränderung oder versuchter Reparatur durch eine nicht autorisierte 
Person zustande gekommen sind. 

Die oben aufgeführten Garantien ersetzen alle anderen ausdrücklichen oder implizierten Garantien und Apogee schließt 
die Haftung für Verkäuflichkeit oder Eignung für einen bestimmten Zweck ausdrücklich aus. Der Käufer nimmt zur 
Kenntnis und bestätigt, dass das Unternehmen in keinem Fall weder für spezielle oder mittelbare Schäden noch für 
Neben- und Folgeschäden oder für Verletzung, Verlust oder Schäden an Personen und/oder Eigentum, die sich aus 
fehlerhaftem Funktionieren dieses Produkt ergeben, haftbar gemacht werden kann. 

USA: Einige Bundesstaaten gestatten den Ausschluss einer implizierten Gewähr oder mittelbarer, bzw. von Folgeschäden 
nicht, so dass obige Beschränkung oder Ausschluss für Sie unter Umständen nicht gilt. Diese Garantiebestimmungen 
erteilen Ihnen bestimmte Rechte: je nach Gerichtsbarkeit stehen Ihnen unter Umständen weitere Rechte zu. 

Wartungsinformationen

Ensemble enthält keine Teile, die vom Benutzer gewartet werden können: Wenden Sie sich für die Reparatur und das 
Upgrade des Gerätes an qualifiziertes Fachpersonal. Die Garantie erlischt, falls Sie die Komponenten im Innern des 
Geräts manipulieren. Sollten Sie weitere Fragen haben, wenden Sie sich bitte an Apogee. 

Falls Ihr Ensemble upgraded oder repariert werden muss, setzen Sie sich mit Apogee in Verbindung, bevor Sie das Gerät 
versenden, damit Ihnen Autorisierungsnummer zur Rückgabe des Geräts erteilt werden kann. Diese Nummer dient Ihnen 
als Referenz und beschleunigt den Rücksendungsvorgang. Sendungen müssen im Voraus bezahlt und versichert sein, 
falls im Vorhinein nichts anderes ausgemacht wurde. 

WICHTIG: SENDUNGEN, DIE NICHT IM VORAUS BEZAHLT WURDEN UND SENDUNGEN OHNE 
AUTORISIERUNGSNUMMER WERDEN NICHT AKZEPTIERT. 

Registrierung und Garantie
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